BAB Il
ANALISIS DAN PERANCANGAN

I11.1. Analisis Sistem yang Berjalan

Melihat kebutuhan akan informasi tentang Lokasi Dealer merupakan hal
yang penting bagi setiap masyarakat yang ingin mengetahui alamat, lokasi Dealer
yang akan di promosikan. Namun kesulitan umum yang sering dialami oleh
mayarakat adalah tidak terdapat informasi yang cukup dan tidak mengetahui
alamat dan lokasi Dealer yang ada di Medan tersebut. Dalam aplikasi yang dibuat
ini akan membantu masyarakat dalam mendapatkan informasi Alamat dan Dealer
yang ingin diketahui. Menyajikan sebuah peta yang dapat berinteraksi dengan
penggunanya sehingga dapat memberikan informasi yang lebih akurat. Adapun
analisis sistem ini meliputi input, proses dan output yang dijabarkan sebagai

berikut :

111.1.1. Analisis Input

Analisis sistem input yang sedang berjalan pada sistem yang lama adalah
data Dealer dan data alamat Dealer yang akan dipasarkan dalam bentuk brosur
yang akan disebarkan kepada masyarakat. Berikut adalah gambar Dealer di salah

satu cabang kota medan.
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BERANDA PETA BLOG DAFTAR LOKASI JARAK LOKASI BUKU TAMU ADMINISTRATOR TENTANG KAMI

Titik Lokasi Penjualan Suku Cadang Mobil Toyota Auto2000

Tanggal 16 Sep2014  Ditulis Oleh Soli

PEDULI UMKM, ASTRA MITRA PECINTA AVANZA ASAL INI TAMPANG ANYAR TOYOTA
VENTURA IKUT BANGUN INDONESIA DAN MALAYSIA CAMRY
KETEMUAN DI ANCOL

EKONOMI NASIONAL

Baca Artike] INI TAMPANG ANYAR TOYOTA
Baca Artike] PEDULI UMKM. ASTRA MITRA Baca Artike] PECINTA AVANZA ASAL CAMRY
VENTURA IKUT BANGUN EKONOMI NASIONAL INDONESIA DAN MALAYSIA KETEMUAN DI
ANCOL

Titik Lokasi Penjualan Suku Cadang Mobil Teyota Auto2000
Titdk Lokasi Penjualan Suku Cadang Mobil Toyeta Aute2000 € 2014 By Soli
Dirancang Oleh Soli

Gambar I11.1. Iklan Dealer

111.1.2. Analisis Process

Proses yang terjadi pada sistem yang dijelaskan pada langkah-langkah:

Sistem Informasi Geografis Titik Lokasi Penjualan Suku
Cadang Mobil Toyota Auto 2000

Home Service Masyarakat

Papan lklan / Brosur Papan lklan / Brosur
Auto2000

Auto2000

\

Mengingat

Alamat
Mengunjungi [ Mengunjungi
Auto2000 o Auto2000
A 4

SELESAI

Gambar 111.2. Flow Of Document Lokasi Dealer

Phase
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1. Masyarakat mendapatkan informasi mengenai lokasi Dealer yang berada di

kota Medan.

2. Kemudian Masyarakat mengingat atau mencatat alamat lokasi Dealer tersebut.

pengunjungan ke lokasi Lokasi Dealer yang mereka ketahui.

111.1.3. Analisis Output

Setelah mendapatkan informasi Lokasi Dealer,

Masyarakat melakukan

Output yang dihasilkan dari sistem adalah informasi-informasi tempat

Lokasi Dealer yang ada di kota dan mengunjungi Lokasi Dealer yang di inginkan

maka Masyarakat akan mendapatkan jasa pelayanan sesuai dengan kebutuhan

Masyarakat yang diberikan oleh pihak Lokasi Dealer yang bersangkutan.

Tabel.l11.1. Daftar Dealer

No

Nama Dealer

Alamat Lengkap

Longitudinal

Latitude
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I11.2. Evaluasi Sistem yang Berjalan
Sistem yang sedang berjalan memiliki beberapa kelemahan yang
dijabarkan sebagai berikut:

1. Tidak adanya sistem informasi geografis lokasi cabang Dealer Dealer
khususnya di kota Medan sehingga konsumen kesulitan menemukan Dealer
Dealer.

2. Belum adanya sistem yang menentukan jarak terdekat dan terjauh antar
Dealer Dealer.

3. Penyebaran informasi mengenai Dealer Dealer tidak efisien dan efektif

dikarenakan penyebaran informasi hanya di dapatkan melalui berita iklan.

111.3. Desain Sistem

Berdasarkan hasil analisa sistem pada penelitian ini dibagi menjadi dua
desain, yaitu desain sistem secara global untuk penggambaran model sistem
secara garis besar dan desain sistem secara detail.
111.3.1.Desain Sistem Secara Global

Desain sistem secara global menggunakan bahasa pemodelan UML yang
terdiri dari Usecase Diagram, Class Diagram, Activity Diagram dan Sequence
Diagram.
111.3.1.1. Usecase Diagram

Secara garis besar, bisnis proses sistem yang akan dirancang digambarkan

dengan usecase diagram yang terdapat pada Gambar I11.2 :
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Sistem Informasi Geografis Titik Lokasi Penjualan Suku
Cadang Mobil Toyota Auto 2000

A
5
a
c
o

Data Konten -7

<includ

<extends>
Data Dealer -<extends>-("Upload Gambar

< <extends>

e>
\ Upload
<include> Thumbnail

Peta Dealer

X

Administrator

Daftar Dealer

Gambar I11.2. Use Case Diagram Sistem Geografis Lokasi Dealer Medan
111.3.1.2. Activity Diagram
Bisnis proses yang telah digambarkan pada use case diagram di atas

dijabarkan dengan activity diagram :
1. Activity Diagram Melihat Peta

Aktivitas melihat peta diterangkan dalam langkah-langkah state, dimulai dari
kegiatan melihat panel peta kemudian mencari Artikel Lokasi Dealer, selanjutnya
menekan tombol atau link yang ada pada peta dan yang terakhir melihat informasi

yang di sajikan dalam peta yang ditunjukkan pada gambar I11.3:
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®
J

Halaman Utama

< Click Peta Dealer >

Click Salah Satu marka Dealer

< Melihat Informasi Lokasi Dealer >

O

Gambar 111.3. Activity Diagram Melihat Peta

2. Activity Diagram Login Administrator Website

Aktvitas proses login admin diterangkan dalam langkah-langkah state,
dimulai dari memasukkan username, memasukkan password, jika profil valid
maka sistem akan mengaktifkan menu administrator, sedangkan jika tidak valid,

maka tampilkan pesan kesalahan yang ditunjukkan pada gambar I11.4:

®

[ Memasukkan Username

L

[ Memasukkan Password j

i valid invalid i

{Aktifkan Menu Administratorj ( Menampilkan Pesan Error ]

0

Gambar I11.4. Activity Diagram Login Admin

3. Activity Diagram Mengolah Data Lokasi Dealer
Aktivitas proses mengolah data Lokasi Dealer diterangkan dalam langkah-

langkah state yang ditunjukkan pada gambar 111.5:
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¢

( Memilih aksi pada form data Dealer >
1
| | |

Penc\[rian Tambah Ediit HBEUS
C Memilih Pencarian ) C Mengisi Data ) C Memilih Data ) ( Memilih Data )
Mengetik Kata Kunci Menyimpan Data Mengubah Data Konfirmasi
g yimp g Penghapusan

C Menekan Enter ) Menzl:fnnpzimbolj CMenyimpan Data) C Menghapus Data \/ Ya

Tidak

(@Y

Gambar I11.5. Activity Diagram Mengolah Data Lokasi Dealer
4. Activity Diagram Mengolah Data Buku Tamu
Aktvitas proses mengolah data Buku Tamu diterangkan dalam langkah-

langkah state yang ditunjukkan pada gambar 111.6:

s

C Memilih aksi pada form Buku Tamu \,

X

Tambah Hapus

C Mengisi Data D C Memilih Data D
\L \|/ _ Tidak
C K D C Konfirmasi )
Menyimpan Data
Penghapusan

\L Ya
M k T bol
enekan 1ombo D C Menghapus Data 1

Kirim

@

Gambar I11.6. Activity Diagram Mengolah Data Buku Tamu
5. Activity Diagram Mengolah Data Blog
Aktvitas proses mengolah data Blog diterangkan dalam langkah-langkah state

yang ditunjukkan pada gambar 111.7:
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*

C Memilih aksi pada form Blog }
L

Pencaran Ta mb h Ed Ha P

( Memilih Pencarian ) ( Meng|5| Data J ( Memilih Data ) C Memilih Data )

. . . Konfirmasi
(Mengetlk Kata Kunm) C Menyimpan Data ) C Mengubah Data ) C Penghapusan
( Menekan Enter ) Menelfan Tombo') C Menyimpan Data) ( Menghapus Data Da

Simpan

Tidak

(@

Gambar 111.7 Activity Diagram Mengolah Data Blog

6. Activity Diagram Mengolah Upload Gambar
Aktvitas proses mengolah data upload gambar diterangkan dalam langkah-
langkah state yang ditunjukkan pada gambar 111.8:

¢

G\/Iemilih aksi pada form upload gamban,

Upload Download Har‘lus
Chose File > C Memilih data > C Memilih Data
Tidak
KonflrmaS|
Memilih gambar
Penghapusan
Ya
Menekan Tombol Menekan Tombol
Menghapus Data
upload download

®

Gambar 111.8. Activity Diagram Mengolah Data Upload Gambar



7. Activity Diagram Mengolah Upload Thumbnail

Aktvitas proses mengolah data upload thumbnail diterangkan dalam langkah-

langkah state yang ditunjukkan pada gambar 111.9:

thumbnail

—

Upload Download Hapus

C Memilih aksi pada form upload \/

Chose File > C Memilih data > C Memilih Data >
K f Tidak
CMemlllh thumbnall> onfirmasi
Penghapusan
Ya
CMenekan Tombol> Menekan Tombol C o
upload download ghap )(—

®
Gambar 111.9. Activity Diagram Mengolah Data Upload Thumbnail

111.3.1.3. Class Diagram

Rancangan kelas-kelas yang akan digunakan pada sistem yang akan dirancang

dapat dilihat pada gambar 111.10 :
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b jal .
gambar dealer jalan P
-id - Kode_Tempat - Kode_Jalan
-nhame - Nama_dealer - Nama_Jalan - Kode_Tempat
- type - Alamat - Tipe_Jalan [ - jarak_mil
- size - Gambar - Lon - jarak_Km
- content - Lon - lat - waktu_tempuh
- Lat
- Keterangan
‘—usin usjng
J using
Connection
—using > konten
ConnectionManager()
€ - Kode_Konten
komentar T - Tanggal
- Kode_Komentar [-using - Terbit
- Nama using using »Ju.dul
- Email - Isi
- Tanggal - Thumbnail
- Pesan |
thumbnail using
-id user
-name - 1d_User
- type - Username
- size - Password
- content _Nama

Gambar 111.10. Class Diagram Sistem Informasi GIS Lokasi Dealer

111.3.1.4. Sequence Diagram

Rangkaian kegiatan pada setiap terjadi event sistem digambarkan pada
sequence diagram berikut:
1. Sequence Diagram pada Form Peta

Serangkaian kegiatan saat terjadi event pada form peta dapat dilihat pada

gambar I111.11 :
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r FO FO

User Main form Form Peta

Menu ()
click form Peta ()

Tampilkan
Menu ()

database ()

\
\
\
\
\
\
:] Koneksi
\

Gambar I11.11. Sequence Diagram Form Peta
2. Sequence Diagram pada Form Login
Serangkaian kegiatan saat terjadi event pada form login dapat dilihat pada

gambar 111.12 :

T O O O O

Administrator Main form Form Login Proses Login Halaman
Web5|te Administrator

D \ \
D:] Menu ()
| validasi nama
click form login dan password ()

Tampilkan Fom ()

\
\
\
\
\

\ \ m

\ \

\ \

| ! Invalid ()

\ {

| | Login sukses ()

\ \

\ \

\ \

\ \

\ \

\

o

Gambar 111.12. Sequence Dlagram Form Login
3. Sequence Diagram pada Form Data Dealer
Serangkaian kegiatan saat terjadi event pada form Dealer dapat dilihat pada

gambar 111.13 :
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: FO O O O

Administrator

Main form Form Data dealer Proses Dealer
Website

Tampilkan Fom ()
>

Menu ()

R

click form
dealer ()

C——————

\
\
\
\
\
\
\
| update data () |

\

\

\

\

\

\

\

o

Koneksi |
database ()

Sai \

\

\

\

\

\

|

\

\

\

| deletel data()

|

Koneksi
database ()
Close form ()
Update
‘ data dealer

—

\
Gambar 111.13 Sequence Diagram Form Dealer

4. Sequence Diagram pada Form Data Konten
Serangkaian kegiatan saat terjadi event pada form data konten dapat dilihat

pada gambar 111.14 :

I FO KO O O

Administrator Main form Form Blog Proses Konten
Website

W ‘ | \
Tampilkan Fom () D
|

[l:‘ Menu ()

\ \ !

\ \ !

\ \ !

\ \ !

click form | | ‘
Blog () m D |
update data () }

:‘ \

\

\

\

\

\

Koneksi
database ()

\
deletel data ()
Koneksi
database ()
77777777 [

Update

‘ a konten
\ \
\ I He——ee—-
\ \ \ ‘
| | | ‘

Gambar I11.14. Sequence Diagram Form Data Konten

Close form ()
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5. Sequence Diagram pada Form Data Buku Tamu
Serangkaian kegiatan saat terjadi event pada form buku tamu dapat dilihat

pada gambar 111.15 :

r O O O O

Administrator Main form  Form Data Buku Tamu Proses Buku tamu
Website

Tampilkan Fom ()
|

U:]Menu ()

[ click form

\ \
\ \
\ \
\ \
\ \
[ \
Buku Tamu () D D
| update data ()
Koneksi

| j database ()

| : ,,,,,,,,

\

\

\

| deleteldata() _|
Koneksi
database ()
| Update
a buku tamu

Close form ()

\
\
| \
i \ \ \

Gambar 111.15. Sequence Diagram Form Buku Tamu
6. Sequence Diagram pada Form Upload Gambar

Serangkaian kegiatan saat terjadi event pada form upload gambar dapat dilihat

pada gambar 111.16 :

: O KO O O

Administrator Main form Form Upload Gambar Proses gambar
Website

D \ \ !

Tampilkan Fom () |

\

[

Menu () |

I click form |
Upload Gambar |

upload data ()

database ()
Koneksi
database ()
Close form () Update

EJ‘—[‘J ‘ data gambar
| | e — o ‘

U | | |

Gambar 111.16. Sequence Diagram Form Upload Gambar

\
\
\
| Koneksi
\
\
\
\

\
\
[
[
[
\
\
\
Koneksi |
database () |
\
\
\
\
\
\
|
|
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7. Sequence Diagram pada Form Upload Thumbnail
Serangkaian kegiatan saat terjadi event pada form upload thumbnail dapat

dilihat pada gambar 111.17 :

> O O O O

Administrator Main form  Form Upload Thumbnail Proses thumbnail
Website

i \ \ !

Tampilkan Fom () D ‘ ‘
|

\ \
\ \
Menu () | |

click form | |

pload Thumbnail )D

‘ download data ( ‘

\

\

\

\

\

\

\

upload data () [

‘ Koneksi

| database () ‘

\ \

| Koneksi |

database ()

L TSasasei \
\

\ \

| \

\

\

\

deletel data ()
mj Koneksi
database ()
Close form () [T | Update

D‘ﬁ data thumbnail

\ \

\ \ ~ :

Gambar 111.17. Sequence Diagram Form Upload Thumbnail

111.3.2. Desain Sistem Secara Detail

Tahap perancangan berikutnya yaitu desain sistem secara detail yang meliputi
desain output sistem, desain input sistem, dan desain database.
111.3.2.1. Desain Output

Berikut ini adalah rancangan tampilan desain peta yang akan dihasilkan oleh
sistem:
1. Rancangan Form Peta

Form peta berfungsi untuk menampilkan lokasi — lokasi Dealer Dealer yang

disajikan dalam bentuk peta, rancangan dapat dilihat pada gambar berikut :
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TOYOTA
AUT0 2000

Urusan Toyota jadi mudah!

INI TAMPANG ANYAR TOYOTA PEDULI UMKM, ASTRA MITRA PECINTA AVANZA ASAL

CAMRY VENTURA IKUT BANGUN INDONESIA DAN MALAYSIA
EKONOMI NASIONAL KETEMUAN DI ANCOL

- T

; — e e 2 i
Baca Artikel INI TAMPANG ANYAR TOYOTA il s Y
CAMRY Baca Artikel PEDULI UMKM, ASTRA MITRA Baca Artikel PECINTA AVANZA ASAL INDONESIA

VENTURA IKUT BANGUN EKONOMI NASIONAL DAN MALAYSIA KETEMUAN DI ANCOL

Gambar 111.18. Desain Tampilan Peta
2. Rancangan Form Daftar Dealer
Form daftar Dealer berfungsi untuk menampilkan informasi — informasi
Dealer Dealer yang disajikan dalam bentuk tabel, rancangan dapat dilihat pada

gambar berikut :
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©) TOYOTA
AUT0 2000

Urusan Toyota jadi mudah!

BERANDA PETA BLOG DAFTARLOKASI JARAK LOKASI BUKU TAMU ADMINISTRATOR TENTANGKAMI

DAFTAR LOKASI Dialer

Mama Dialer ¥ |

Nama Dialer Alamat Lengkap Longitudinal Latitude

Il Sizingamangarajz Km. 3,8 Amplaz,
Autez000 Amplas . 10994131.376681 302880.515534369
Meorth Sumatra 20148 (081) 7852000

JI Jend.Gatsu Ne.220, Medan. Kota,
Z Auto2000 Gatsu _ 10981054 436476 399552.267078092
Medan. No. Telepon, 061-6452000

TotalData 2

Titik Lokasi Penjualan Suku Cadan
Titik Lokasi Penjualan Suku Cadang M
Dirancang

Gambar 111.19. Desain Tampilan Daftar Dealer

111.3.2.2. Desain Input

Berikut ini adalah rancangan atau desain input sebagai antarmuka pengguna:
1. Desain Form Login

Desain form login dapat dilihat pada gambar 111.20 :

&2 TOYOTA
AUI0 2000

Urusan Toyota jad mudah!

BERANDA PETA BLOG DAFTARLOKASI JARAK LOKASI BUKU TAMU ADMINISTRATOR TENTANGKAMI

Login Admin

Username ‘ ‘

Passward

Titik Lokasi Penjualan Suku Cadan
Titik Lokasi Penjualan Suku Cadang M
Dirancang oli

Gambar 111.20. Desain Form Login

2. Desain Form Data Lokasi Dealer
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Desain form Data Lokasi Dealer dapat dilihat pada gambar 111.21 :

AUT0 2000

Urusan Toyota jadi mudah!

BERANDA LOKASl OLAHBLOG UNGGAH GAMBAR DIALER UNGGAH GAMBAR BLOG OLAH BUKU TAMU KELUAR

Form Pengisian Lokasi Dialer

Mama Dizler ‘

Alamat

Keterangan

Gambar Dialer pilih Gambar v
Koordinat ‘

|| peta

‘ NamaDialer ¥

[ oo

Gambar 111.21. Desain Form Lokasi Dealer

3. Desain Form Data Konten

Desain form Data Konten dapat dilihat pada gambar 111.22 :
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TOYOTA
AUI0 2000

Urusan Toyota jadi mudah!

BERANDA LOKAS!I OLAHBLOG UNGGAH GAMBAR DIALER UNGGAH GAMBARBLOG OLAH BUKU TAMU KELUAR

Pengolahan Blog Website
Judul |
Diterbitkan | Pilin ¥ Gambar| Pilih Thumbnail v
Gambar 111.22 Desain Form Data Konten
Desain Form Data Pangkalan Buku Tamu

Desain form Data Pangkalan Buku Tamu dapat dilihat pada gambar 111.23 :

AUT0 2000

Urvsan Toyota jadi mudah!

Titik Lokasi Penjualan Suk
Titik Lokasi Penjualan Suku Cada Soli
Dirant i

Gambar 111.23. Desain Form Buku Tamu

Desain Form Data Upload Gambar
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Desain form Data upload gambar dapat dilihat pada gambar 111.24 :

AUT02000

Urusan Toyota jadi mudah!

BERANDA LOKASI OLAHBLOG UNGGAH GAMBARDIALER UNGGAH GAMBAR BLOG OLAH BUKU TAMU KELUAR

Pilih Lokasi Gambar

‘ Choose File | Mo file chosen ‘

Daftar Gambar Titik Lokasi Penjualan Suku Cadang Mabil Toyota Auto2000

20140830_181652pg Download Delete
20140830_181724,pg Download Delete
20140830_181925,pg Download Delete
20140830_190503,pg Download Delete
amplasjpg Download Delete
gatsu.,jpg Download Delete

Titik Lokasi Penjualan Suku Cada

Titik Lokasi Penjualan Suku Cada
Dirancan

Gambar 111.24. Desain Form Data Upload Gambar

6. Desain Form Data Upload Thumbnail

Desain form Data upload thumbnail dapat dilihat pada gambar 111.25 :

AUT02000

Urusan Toota jadi mudiah!

BERANDA LOKASI OLAHBLOG UNGGAH GAMBARDIALER UNGGAH GAMBAR BLOG OLAH BUKU TAMU KELUAR

Pilih Lokasi Gambar

‘ Choose File | No file chosen ‘

Daftar Gambar Untuk Blog

avanzancol jpg Download Delete
camry-e 1409725559671, pg Download Delete
umkm.jpg Download Delete

14 By Soli

Gambar 111.25. Desain Form Data Upload Thumbnail
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111.3.2.3. Desain Basis Data

Desain basis data terdiri dari tahap merancang kamus data, melakukan
normalisasi tabel, merancang struktur tabel, dan membangun Entity Relationship
Diagram (ERD).
111.3.2.3.1. Kamus Data

Kamus data merupakan sebuah daftar yang terorganisasi dari elemen data
yang berhubungan dengan sistem, dengan definisi yang tepat dan teliti sehingga
pemakai dan analis sistem akan memiliki pemahaman yang umum mengenai
input, output, dan komponen penyimpan. Kamus data penyimpanan sistem yang
akan dirancang dapat dilihat sebagai berikut :
1. Gambar = @Id + Name + Type + Size + Content.
2. Dealer = @Kode_Tempat + Nama_Dealer + Alamat + Gambar +

Lon + Lat + Keterangan.

3. Jalan = @Kode_Jalan + Nama_Jalan + Tipe_Jalan + Lon + Lat.
4. Jarak = @Kode Tempat + Jarak Mil + Jarak Km +

Waktu_Tempuh.

5. Komentar = @Kode_Komentar + Nama + Email + Tanggal + Pesan.

6. Konten = @Kode_Konten + Tanggal + Terbit + Judul + Isi +
Thumbnail.

7. Thumbnail = @Id+ Name + Type + Size + Content.

8. User = @Id_User + Username + Password + Nama.
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111.3.2.3.2. Desain Tabel
Setelah melakukan tahap normalisasi, maka tahap selanjutnya yang dikerjakan
yaitu merancang struktur tabel pada basis data sistem yang akan dibuat, berikut ini

merupakan rancangan struktur tabel tersebut:

1. Struktur Tabel Dialer

Tabel dialer digunakan untuk menyimpan data Kode _Tempat, Nama_Dialer,
Alamat, Gambar, Lon, Lat, Keterangan, selengkapnya mengenai struktur tabel ini

dapat dilihat pada tabel I11.1 di bawah ini:

Tabel III.1 Rancangan Tabel Dialer

Nama Database soli_auto2000

Nama Tabel Dialer
No Nama Field Tipe Data Boleh Kosong Kunci
1. Kode_Tempat int(5) Tidak Primary Key
2. Nama_Dialer varchar(25) Tidak -
3. Alamat text Tidak -
4. Gambar int(11) Tidak Foreign Key
5. Lon double Tidak -
6. Llat double Tidak -

7. Keterangan text Tidak -
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2. Struktur Tabel Gambar

Tabel gambar digunakan untuk menyimpan data id, name, type, size, content,

selengkapnya mengenai struktur tabel ini dapat dilihat pada tabel 111.2 di bawah

ini:
Tabel II1.2 Rancangan Tabel Gambar
Nama Database soli_auto2000
Nama Tabel Gambar
No Nama Field Tipe Data Boleh Kosong Kunci
1. id int(11) Tidak Primary Key
2. name text Tidak -
3. type varchar(30) Tidak -
4. size int(11) Tidak -
5. content longblob Tidak -

3. Struktur Tabel Jalan

Tabel jalan digunakan untuk menyimpan data Kode Jalan, Nama_Jalan,
Tipe_Jalan, Lon, Lat, selengkapnya mengenai struktur tabel ini dapat dilihat pada

tabel 111.3 di bawah ini:

Tabel I11.3 Rancangan Tabel Jalan

Nama Database soli_auto2000

Nama Tabel Jalan



No

Nama Field

Kode_Jalan

Nama_Jalan

Tipe_Jalan

Lon

Lat

Tipe Data

int(5)

varchar(30)

varchar(10)

double

double

4. Struktur Tabel Jarak

S7

Boleh Kosong Kunci

Tidak

Tidak

Tidak

Tidak

Tidak

Primary Key

Tabel jarak digunakan untuk menyimpan data Kode Tempat, Jarak Mil,

Jarak_Km, Waktu Tempuh, selengkapnya mengenai struktur tabel ini dapat

dilihat pada tabel 111.4 di bawah ini:

Tabel II1.4 Rancangan Tabel Jarak

Nama Database

Nama Tabel
No Nama Field
1. Kode_Tempat
2. Jarak_Mil
3. Jarak_Km
4. Waktu_Tempuh

soli_auto2000

Jarak

Tipe Data

int(5)

double

double

double

Boleh Kosong Kunci

Tidak -

Tidak -

Tidak -

Tidak -
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5. Struktur Tabel Komentar

Tabel komentar digunakan untuk menyimpan data Kode_Komentar, Nama,
Email, Tanggal, Pesan, selengkapnya mengenai struktur tabel ini dapat dilihat

pada tabel 111.5 di bawah ini:

Tabel II1.5 Rancangan Tabel Komentar

Nama Database soli_auto2000

Nama Tabel Komentar

No Nama Field Tipe Data Boleh Kosong Kunci
1. Kode_Komentar int(5) Tidak Primary Key
2. Nama varchar(25) Tidak -
3. Email varchar(25) Tidak -

4. Tanggal datetime Tidak -
5. Pesan text Tidak -

6. Struktur Tabel Konten

Tabel konten digunakan untuk menyimpan data Kode Konten, Tanggal,
Terbit, Judul, Isi, Thumbnail, selengkapnya mengenai struktur tabel ini dapat

dilihat pada tabel 111.6 di bawah ini:

Tabel I11.6 Rancangan Tabel Konten

Nama Database soli_auto2000

Nama Tabel Konten



No

Nama Field

Kode_Konten

Tanggal

Terbit

Judul

Isi

Thumbnail

Tipe Data

int(11)

timestamp

varchar(6)

text

text

int(11)

7. Struktur Tabel Thumbnail

Boleh Kosong

Tidak

Tidak

Tidak

Tidak

Tidak

Tidak
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Kunci

Primary Key

Foreign Key

Tabel thumbnail digunakan untuk menyimpan data id, name, type, size,

content, selengkapnya mengenai struktur tabel ini dapat dilihat pada tabel 111.7 di

bawah ini:

Tabel II1.7 Rancangan Tabel Thumbnail

Nama Database

Nama Tabel

No Nama Field
1. id

2. name

3. type

4. size

soli_auto2000

Thumbnail

Tipe Data

int(11)

text

varchar(30)

int(11)

Boleh Kosong

Tidak

Tidak

Tidak

Tidak

Kunci

Primary Key
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5. content longblob Tidak -

8. Struktur Tabel User

Tabel user digunakan untuk menyimpan data Id_User, Username, Password,

Nama, selengkapnya mengenai struktur tabel ini dapat dilihat pada tabel 111.8 di

bawah ini:
Tabel I11.8 Rancangan Tabel User

Nama Database soli_auto2000

Nama Tabel User
No Nama Field Tipe Data Boleh Kosong Kunci
1. Id_User int(11) Tidak Primary Key
2. Username varchar(12) Tidak Unique
3. Password varchar(12) Tidak -
4. Nama varchar(25) Tidak -

111.3.2.3.2. ERD (Entity Relationship Diagram)
Tahap selanjutnya pada penelitian ini yaitu merancang ERD untuk
mengetahui hubungan antar tabel yang telah didesain sebelumnya, ERD tersebut

dapat dilihat pada gambar 111.26 :
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Gambar

1

Kode_Konten

Tanggal

1

Komentar

Tanggal

Thumbnail

Gambar 111.26. Diagram ERD

I11.4. Logika Perhitungan
Perhitungan untuk menentukan jarak tempuh dari jarak asal ke tempat
jarak Dealer terdekat dengan jarak asal dapat dilihat dengan algoritma perhitungan
sebagai berikut :
A=(Lon A, Lat A)
B = (Lon B, Lat B)
s=LonA—-LonB
d = Sin ((lat A) x sin (lat B) + cos (lat A) x cos (lat B) x cos (=)
d =cos (d)

mil =d x 60 x 1.15.15



1 mil = 1.609344 km

dkm = 1.609344 x dMil

Contoh : d =20 km
v = 30 km/jam
t=v=30=1.5jam
d 20
Keterangan :
1. A =jarak asal
2. B = Dealer terdekat dengan jarak asal
3. d =distance/ jarak
4. t =time/waktu
5. = =diferensial longitudinial koordinat (delta)
6. v =Kkecepatan
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